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Outline of the document
ATOM Platform provides users to develop various extensions to out-of-the box capabilities.

1) Device Drivers - Device Drivers allow ATOM to work with devices to Collect
configuration, Provision Configuration, Collect Performance & Other Operational Data,
Execute Show and Diagnostic Commands.

a) Configuration Discovery & Provisioning
b) Performance & Inventory Collection (SNMP, SNMP Trap, Syslog, Telemetry)

2) Network Automation
a) Stateful Services like Application Delivery, L3 VPN, L2 VPN, Day0, Cloud

Interconnect etc.,
b) MOP Automation like Software Upgrade, Password Rotation etc.,

This document covers Network Automation Stateful Services Development flows that have the
following life cycle:

a. Create - Create a green field service

b. Update - Update Service. This may be repeated multiple times

c. Delete - Retire the service

Following is a high level breakdown of the content:

1. Installing ATOM locally
2. Working with Development tooling
3. Services Development against ATOM platform
4. Deploying, Upgrading & Operating Services in ATOM

In the Appendix, additional examples, extensions, library utils and FAQs are available in detail.
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Intended Audience
This document is meant for the reader who is interested in developing network services or
applications against ATOM.

ATOM relies heavily on YANG modelling language and RESTCONF. Hence, a good knowledge of
YANG and working knowledge of RESTCONF are required.

Service logic is implemented in python hence good working knowledge of python is required.

ATOM SDK is built on top of the Gradle build system. This document explains the build
commands in detail.

YANG : https://tools.ietf.org/html/rfc7950

RESTCONF : https://tools.ietf.org/html/rfc8040

Gradle : https://gradle.org/

Setting up the environment for ATOM
Localhost
ATOM software is dockerized and is provided as a self-contained installation with all the
required components. ATOM can also be setup in your machine locally and this section covers
some of the prerequisites and steps for ATOM installation locally.

Prerequisites
● Docker & Docker Compose

(Refer Appendix for Installation Steps)

● 32 GB Available RAM
● 4 CPU Cores

Deployment Images
All the images required for deploying the components of ATOM will be pulled from the
repositories, created in Quay (https://quay.io/repository/).

The images have been tagged with a specific name, in the format given below:

quay.io/<organization>/<image name>:<tag>
Example: quay.io/release/atom-core:8.X.X.X.YYYYY

Deployment scripts and files
Deploying ATOM in the local setup involves deploying the components using docker-compose
and shell scripts. To simplify the deployment in your environment, the required scripts and files
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are organized into folders and are provided by Anuta Networks (in a zipped format with MD5 to
verify).

ATOM Docker Compose Steps
1. Unzip the deployment files given by Anuta Networks and open the terminal.

The file named docker-compose.yaml will be used in ATOM installation.

2. Start the containers, which in turn starts the ATOM local host setup, using the below
command:

./runcompose.sh ATOM_BUILD_NUMBER docker-compose.yaml

For example, if the ATOM_BUILD_NUMBER is 8.8.0.0.36210.2012200527, then the command to

be entered is

./runcompose.sh 8.8.0.0.36210.2012200527 docker-compose.yaml

3. The command displays the available options to start ATOM, and prompts for the choice to be
entered. The options are:

1. All : Includes Orchestration + Monitoring

2. Workflow : Includes Modelling + Workflow

3. Portainer : To start the GUI based docker manager container

4. Orchestration : To deploy components required for modelling and orchestration of
services.

5. Clean : Deletes the persistent volumes

6. Usage : Displays the usage of the command

7. Kill : Kill all the running containers based on the previous selected option

8. Quit

Preferred choice is 2 which provides Workflow and Orchestration capabilities.

4. After the choice is entered, images get downloaded based on the given choice (it might take
several minutes to download all the images for the first time), and the containers get started.

A snapshot of images getting downloaded and getting started:
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5. After all the images are downloaded, check the docker status using below cmd

docker ps
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Docker containers should be in a healthy state after a few minutes.

6. Now open ATOM either with port number 8890 i.e. http://localhost:8890 or with port 443 i.e.
https://localhost

Once the licence file given by Anuta Networks is uploaded, login to ATOM UI using the
credentials (username/password: admin/admin).

7. To view the logs of the ATOM docker setup use the command

docker-compose logs -t -f

8. To bring down the docker containers (which in turn brings down the ATOM local host), enter
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the below command and choose option 7

./runcompose.sh 8.8.0.0.36210.2012200527 docker-compose.yaml

After choosing option 7, it further displays the available options to bring down the ATOM local
host setup. Enter the preferred option to bring the setup down.

Once the preferred option is entered, the running docker containers are stopped.
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Overview of Modelling in ATOM
Anuta ATOM platform with it’s layered, YANG model driven approach helps in delivering vendor
neutral, extensible and maintainable network services for multiple domains such as branch/CPE,
Data Center, Cloud, and Carrier Core networks.

Network Service or application development involves the following major components:
1. Device Model (Not required for Native/Openconfig Models)

a. Abstracted object model defined using IETF YANG
b. Defined once for each device feature or function

2. Vendor Plugin (Not required for Native/Openconfig Models)
a. Common model mapped to vendor specific CLI or API
b. Defined once for each vendor or OS type of a platform

3. Service Model
a. Service description in YANG
b. Mapping to Device models
c. Glue logic to augment service model & mappings with business logic (Optional)

ATOM SDK and Platform provides a full life cycle for network services & apps in - Design,
Develop, Package, Deploy, Test, Upgrade.

Each of the individual blocks covered under ATOM SDK development are illustrated below:
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How Service Modeling Works

Service Package Development
Create the Service package
After the successful one time setup of the ATOM SDK environment (Refer Appendix section
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ATOM SDK), you can create packages of your choice.

1. Run the command to create the requisite package:

python sdk.py -c

create.py: This script helps you create different types of package; service package, device
package, or device driver package.

2. Select the type SERVICE_MODEL package type as shown below:

3. Enter the name of the package and other inputs as shown below
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After the successful run of the above build, the service package folder structure for
service development purpose is created. The service package folder contains the
following artifacts

Update the Dependencies & Version in build.gradle
After a successful creation of a package, there could be some additional package(s) required as
‘dependencies’. Accordingly modify the default dependencies listed in the build.gradle file,
which is located in the root level of the created package.

In scenarios where service performs API invocations against Device or other Models, make sure
dependency of that respective model package is there along with the servicemodel package
which the library utils.

Let’s consider a Service which performs invocations against Juniper Device Models, then make
sure dependencies of servicemodel-7.0.4.0, juniper-8.0.0.1, juniper_cli-8.0.0.1 are mentioned as
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below. (The package names are a combination of the name of the package and the version
number separated by a hyphen)

Resolve the dependencies

Run the command : gradle build --refresh-dependencies

Successful execution of this command ensures that the dependencies mentioned in the

build.gradle file are mapped fine.

Update the version

In the “build.gradle” file, metadata about the package is present in the version & packageXml
object. Update the version based on the revision of the service package you are working on.

Yang Modelling and Service Logic

Network Service modelling and defining of Service logic in python can be done within the model

and scripts folder respectively of the created service package structure. Refer to Service

Modelling section for detailed procedure of it.

Archive the Service Package

Once the modelling and service logic are defined in the respective package structure, use the

gradle task “gradle archive” for creating the uploadable zip with its dependencies.

The zip will be stored in the build folder and is ready for Upload to ATOM.
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Service Yang Modeling and Logic
Contents of a Service package
The service package which can be uploaded into ATOM as a zip format typically contains the

following entities:

1. The model folder contains the following:
a. <service_name>.yang file - Contains the schema of the service defined in YANG

2. The scripts folder contains python based service logic consiqueting following files
typically:

a. <service_name>.py - Contains the logic binding of the service to the device

Generates the device model operations with reference to the service defined in
the yang model file and also registers service in ATOM

b. plugin.py - Code for adding the service as a new plug-in to ATOM
c.  _init_py - Required to make ATOM treat the directories as containing packages

3. The package.xml file contains the metadata about the service.
a. Information such as package name, version, module name, type and description

should be provided.

This section outlines the procedure for creating, deploying, and testing a service package built
by using the ATOM SDK.

Procedure for Modelling & Defining Logic
Follow these steps for creating a service package:

1. Define the service model file - write the service.yang
a. Add Yang validations & constraints for building intelligence in the model
b. Define ATOM extensions useful to map service node to device node
c. Above extensions will help for codegen in step2

2. AutoGenerate service logic using SDK & Define any custom logic in python

Let us take an example of building a service package (day0service package) from service.yang
file (day0config.yang) using Plugin Tasks for package development. This day0service is intended
to deploy some of the day0 features on the device after it was plugged into the lab with
management reachability.

Create a Service model .yang file
1. Extract the provided ATOM SDK .zip and Setup the environment as per steps mentioned

in Setting up the environment for package development.
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2. Select the required package type as SERVICE_MODEL.

3. Give the name of the service model: day0config

After the successful run of the build, the service package, day0config gets created.

Note:: In the service package development process, make sure the  package folder
name, yang file and module names are the same.

4. Take reference of the .yang present in the examples folder of ATOMSDK to develop
day0config.yang service model and place it day0config package path
day0config/src/main/model. This model is for creating multiple user login a/c’s on the
device as part of day0 configurations to be done on the device.

module day0config {

namespace "http://anutanetworks.com/day0config";

prefix day0config;

import controller {

prefix ac;

}
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import user {

prefix cu;

}

import ncx-extensions {

prefix n-ext;

}

organization

"Anuta Networks";

description

"This module contains a collection of YANG definitions for

day0 configuration ";

revision 2016-06-16 {

description

"Initial revision";

}

augment "/ac:services" {

container day0services {

list day0service {

key "name";

leaf name {

type string;

description

"string";

}

leaf device-ip {

type leafref {

path "/ac:devices/ac:device/ac:id";

}

mandatory true;

description

"device-ip";

}

container users {

list user {

key "name";
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leaf name {

type string;

description

"string";

n-ext:maps-to "/ac:devices/ac:device[ac:id=current()/../../device-ip]/cu:users/user/name";

}

leaf password {

type string;

description

"string";

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../../device-ip]/cu:users/user/password";

}

leaf password-level {

type enumeration {

enum "0";

enum "7";

}

description

"password encryption level indicator";

n-ext:maps-to "/ac:devices/ac:device[ac:id=current()/../../device-
ip]/cu:users/user/password-level";

}

}

}

}

}

}

}
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5. In the above yang model we can see various Yang Constraints and ATOM extensions
added to bring intelligence into the model and enhance the capabilities of ATOM
UI/platform and SDK.

AutoGenerate & Define Service logic in Python
For any given service.yang ATOM SDK has the capability to generate service package structure

and the required files for service logic by using python libraries available at

atomsdk/packages/servicemodel/scripts/. For detailed reading on python libraries refer to the

Appendix section Library Utils for Service Modelling.

SDK can auto generate python based business logic completely where custom logic addition is

not required at all. To utilize the functionality of the full code generation, use the extension,

maps-to, for all leaf nodes in a service.yang file.

Example: n-ext:maps-to <device model x-path/rc-path>

Few more ATOM yang extensions relevant to UI and code-generation refer Appendix section

ATOM Extensions to yang.

To generate a service package, make sure the service yang is inside the directory

‘src/main/model’. The user has the flexibility to generate the output in ‘build/generated’ or in

‘src/main’ itself. For details refer plugin task.

Change to current directory i.e. the service  package directory and run the commands

gradle tasks --all (this will display all the tasks)

gradle generateServicePackage(Runs the ServicePackage generate task)

Verify the package is created in the destination folder with below folders and file:
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In the Scripts folder, multiple python files and folders are generated as explained below:

❖ A sample of the plugin.py file that is required for registering and unregistering of
package to ATOM is shown below:

def get_plugin_info():

return Plugin('day0config', '1.0.0')

from com.anuta.service.python.plugin import PythonPlugin

from com.anuta.service.python.plugin import PythonPluginType

from servicemodel import util

import day0config

from day0config_lib import log

class Plugin(PythonPlugin):

"""Class to register day0config plugin to ATOM

"""

def __init__(self, name, version):

self.setName(name)

self.setVersion(version)

self.setPluginType(PythonPluginType.SERVICE_MODEL)

self.setDescription('DAY0CONFIGService Plugin')

def init(self):

log('registering day0config')

day0config.DAY0CONFIGService.getInstance().register()

def shutdown(self):

log('unregistering day0config')

day0config.DAY0CONFIGService.getInstance().unregister()
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❖ A sample of the “day0config.py” file  is as below and explained:

Import Block:

Below block represents importing library servicemodel.util, servicemodel.yang and
servicemodel.devicemgr

from servicemodel import util

from servicemodel import yang

from servicemodel import devicemgr

from day0config_lib import getCurrentObjectConfig

import day0services.day0service.day0service

import day0services.day0service.users.user.user

Handler-Maps

Every use-case contains one main file, here day0config.py with its class
DAY0CONFIGService() having handler maps as below.

Significance of Handler-Maps: When client enters data from UI or from RESTCONF Client
of any entity (container or list) in usecase, respective handler map is called from python
glue logic. Each handler-map is associated with its entity class definition.

class DAY0CONFIGService(yang.AbstractYangServiceHandler):

"""Class for handling day0config service creation request.

"""

_instance = None

def create(self, id, sdata):

config = getCurrentObjectConfig(id, sdata, None)

def __init__(self):

yang.AbstractYangServiceHandler.__init__(self)

self.handler_map = {

'day0config:day0services/day0service':
day0services.day0service.day0service.Day0Service.getInstance(),

'day0config:day0services/day0service/users/user':
day0services.day0service.users.user.user.User.getInstance(),

}
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@staticmethod

def getInstance():

if(DAY0CONFIGService._instance is None):

DAY0CONFIGService._instance = DAY0CONFIGService()

return DAY0CONFIGService._instance

❖ The supporting methods specific to this service package are available in the form of
“day0config_lib.py” file. In addition to these, you can add any other lib python modules,
if required for this service package.

When ATOM SDK is used for code generation of a service.yang file, it will generate a folder

hierarchy within the scripts folder of the generated package as per yang tree structure.

For each folder there will be a service_customization.py file to add modifications required in

auto generated python service logic. For example, a user model which is of a yang type list will

have the following file structure.

Below we can see the structure of code generated within these files.

Class Structure Hierarchy

The structure of the User class is shown below:

class User(yang.AbstractYangServiceHandler):
_instance = None

def __init__(self):
self.delete_pre_processor = service_customization.DeletePreProcessor()
self.create_pre_processor = service_customization.CreatePreProcessor()
self.opaque_args = {}

def create(self, id, sdata):
#Create block

@staticmethod
def getInstance():

if(User._instance == None):
User._instance = User()

return User._instance
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Create (Codegen)

When a client creates the service from UI or via RESTCONF, the payload is sent as an input to

the create() block of service code as sdata. ATOM Platform keeps track of all the references for

device entries/entities it created during a service create operation.

‘create’ code contains below basic structure of generated code

Fetching input values

The input values sent by the client to the python glue logic is captured in inputdict as shown in
the following snippet of the code:

def create(self, id, sdata):
sdata.getSession().addYangSessionPreReserveProcessor(self.create_pre_processor)

#Fetch Local Config Object
config = getCurrentObjectConfig(id, sdata, 'user')

#Fetch Service Model Context Object
smodelctx = ServiceModelContext(id, sdata)

#Fetch Parent Object
parentobj = getParentObject(sdata)

dev = []
inputkeydict = {}
devbindobjs={}
inputdict = {}
opaque_args = self.opaque_args

# START OF FETCHING THE LEAF PARAMETERS
inputdict['name'] = config.get_field_value('name')
inputdict['password'] = config.get_field_value('password')
inputdict['password_level'] = config.get_field_value('password_level')
# END OF FETCHING THE LEAF PARAMETERS

Create logic using input values

The input values given for service yang leafs are assigned to respective leaf variables of device
models based on the maps-to statement defined for that service yang leaf. This mapping is
maintained in a dictionary called mapping_dict.

Create method requires this mapping_dict as one input along with sdata, dev(which is device
object), and addReference.

import servicemodel.device_abs_lib.users.user

if inputdict.get('name') is not None:
servicemodel.device_abs_lib.users.user.user().create(sdata, dev, fill_map_devices_device_users_user(inputdict,

sdata=sdata), addref=True)
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def fill_map_devices_device_users_user(inputdict, sdata=None, pinputdict={}, delete=False, update=False):
mapping_dict_devices_device_users_user = {}
mapping_dict_devices_device_users_user['password'] = inputdict.get('password') if not delete else '' if

inputdict.get('password') is not None else inputdict.get('password')
mapping_dict_devices_device_users_user['password_level'] = inputdict.get('password_level') if not delete else '' if

inputdict.get('password_level') is not None else inputdict.get('password_level')
mapping_dict_devices_device_users_user['name'] = inputdict.get('name') if not update else inputdict.get('name') if

inputdict.get('name') is not None else pinputdict.get('name')
return mapping_dict_devices_device_users_user

In the above we see the create method present in library
servicemodel.device_abs_lib.users.user is invoked which is based on the maps-to statements
defined in the service yang. This create method translates to device entity creation in ATOM
with reference held in the platform based on addReference being True/False.

In case the developer wants to code additional custom logic for service Create, he can do it on

top of generated code within the create() block.

Update (AutoUpdate)

When a client tries to edit an existing service entry, then the payload is sent as an input to the

create() block itself as sdata. The code within the create itself will be executed with latest

updated service parameter values.

ATOM platform handles the update on device entries/entities automatically using the

references it had previously. Hence ATOM as a platform gives AutoUpdate functionality.

In case the developer wants to code additional custom logic for service Update without

affecting Create logic, he can still do it using a flag sdata.autoupdate which gets set as True

when client did an update of service entry. Hence the update specific code customization can be

added under if (sdata.autoupdate) within the create block itself.

Delete (AutoDelete)

With the service entity deleted, ATOM Platform handles the delete of device entries/entities

automatically using the references it had previously. Hence the ATOM as a platform gives

AutoDelete functionality.

In case the developer wants to code additional custom logic for service Delete, he can still do it

by having delete() definition defined.

def delete(self, id, sdata):
#Delete custom logic
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Extending Service Model & Custom Logic
Let us take an example of adding an extra day0 feature (dns-name-server) to the existing
day0service. The service logic should be modified to accommodate the changes in the service
thereby extending the service model.

1. Open the day0config.yang file present in src/main/model and add the dns-name-server
list entry as shown below.

2. Extend the day0config.yang as shown below:

container dns {

list name-server {

key "name-server";

leaf name-server {

description

"Valid IPv4 Address (A.B.C.D for e.x: 172.16.1.1)";

type inet:ipv4-address;

}

leaf vrf-name {

type string;

description

"string, Ex:management";

}

}

}

3. For the service.yang generate service package using ATOM SDK
i. Change to current directory i.e /ServicePackage

ii. Run the commands

gradle tasks --all (this will display all the tasks )
gradle generateServicePackage (Runs the ServicePackage generate task)

4. Verify the package is updated with new service logic and new folders.

i. Open the “name_server.py” file (in the
<pkg>/scripts/day0services/day0service/dns/name_server folder) and look for
the existing python logic.

As ATOM Extensions of the ‘maps-to’ attribute has not been added for the name-server,
the python logic is not fully complete. The logic does not contain the device bindings and
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the corresponding payload.

5. Add the required custom logic in the “service_customization.py” file (in the
<pkg>/scripts/day0services/day0service/dns/name_server folder).

Add the missing name-server device bindings and then the create operation with
name-server payload.

An excerpt of the code from the def process_service_device_bindings of the
“service_customization.py” file is shown below:

if modify:

config = kwargs['config']

inputdict = kwargs['inputdict']

inputkeydict = kwargs['inputkeydict']

devbindobjs = kwargs['devbindobjs']

id = kwargs['id']

opaque_args = kwargs['hopaque']

if dev is None or (isinstance(dev,list) and len(dev)==0):

return

import servicemodel.device_abs_lib.dns_server.name_server

if inputdict.get('name_server') is not None:

servicemodel.device_abs_lib.dns_server.name_server.name_server().create(sdata, dev,
fill_map_devices_device_dns_server_name_server(inputdict, sdata=sdata), addref=True)

6. Open the build.gradle and upgrade service package by modifying value of version field
from 7.0.0.0 to 7.0.1.0
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7. This package can be archived and uploaded to ATOM for use. For archiving manually zip
the model, scripts folders, and the package.xml and upload to ATOM.

For archiving using SDK, change to the directory level of package and run command:
gradle archive

Deploying & Operating Service Packages
Deploying a Service Package

1. Considering the previous created day0config service, Upload the day0config.zip into
ATOM.
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2. Click Add package and upload the day0config.zip and click the OK button.

If any error occurs, verify if all the dependent packages are uploaded and registered in
ATOM.

3. Load the Service Package
To load day0config.zip in ATOM, select the package in the list and click the Load button
and verify that the service package is in “Active” state (true) as shown below.

4. Verify the status of the service package, whether it is LOADED or not.
Go to Administration > Troubleshoot > Services & Metrics > Servers > Components >
Python > ServiceModelPlugin.

5. Click the Statistics tab and verify for day0config state as LOADED.
6. Navigate to Tenants & Services > Services to view the day0config
7. All the above manual steps can be done using SDK gradle cmds.

gradle load (to upload package to ATOM)

gradle activate (to activate package, sets active = true)

gradle deactivate (to deactivate package, sets active = false)

8. For Extending/Migrating the existing day0config-7.0.0.0.zip to day0config-7.0.1.0.zip,
refer to the section, "Upgrading Service packages"
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Testing the Service Package
1. Navigate to Automation > Services to instantiate the day0service service.

Click on day0services below

2. Fill the form and click on the OK button

3. Successfully created day0 service entry can be seen below,
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4. To view details of the task associated with service creation, go to Task viewer and look
for DataModel Create:day0service task. Select the task and click on the Details option to
see the details of the service created. We will be able to see the details of what are sent
as input to day0service.

5. Commands generated for day0service can also be viewed in the Task Details:

Upgrading Service package
1. Service packages can be upgraded to newer versions without disrupting the ATOM.
2. Add the required modifications to the existing service package and tag changes with

appropriate version number in the respective build.gradle file.

3. Create the zip of the required service package to be upgraded.

NOTE: Check that all the tasks running in ATOM are in ‘COMPLETE’ state before

upgrading the package.

4. The package can be upgraded in the ATOM using below gradle task:
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gradle upgrade

This gradle upgrade task will do following steps:

1. Enable’s maintenance mode on ATOM

2. Load the package need to be upgraded

3. Activates the Package and then disables maintenance mode.

NOTE:

1. The command, gradle upgrade, will automatically put ATOM in maintenance mode,

upload the modified package and disable the maintenance mode.

2. If required execute the command ‘gradle clean’ before upgrade.

5. Look for the ‘Active’ state status of the upgraded package.

6. Observe that the status of the Base package (version 7.0.0.0) is set to FALSE and the

upgraded package status is set to TRUE(version 7.0.1.0).
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Exercise: L2Edge Service Modeling
This section describes the procedure for creating a service package for L2Edge service. (in this
example, l2edge.yang is modelled to configure an interface as L2 interface-types access/trunk
with respective vlans)

1. Extract the provided atomsdk zip and create a service package environment by selecting
option of type SERVICE_MODEL and package name as l2edge as per Creating a Package
using SDK.

2. Create l2edge.yang under src/main/model
3. Put below content in l2edge.yang

module l2edge {

yang-version 1.1;

namespace "http://oneandone.net/l2edge";

prefix l2edge;

import controller { prefix ac;}

import junos-conf-root {

prefix jcr;

}

import junos-conf-interfaces {

prefix jci;

}

import junos-conf-vlans {

prefix jcv;

}

import ncx-extensions {

prefix n-ext;

}
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import sdk-extensions {

prefix s-ext;

}

description

"This module provides the l2-edge service";

revision 2018-06-19 {

description

"Initial revision.";

}

augment "/ac:services" {

list l2-edge {

n-ext:ncx-service;

n-ext:ncx-auto-update "ENTITY_LEVEL";

description "Provides configuration for l2-edge ports.The l2-edge service provides network
connectivity for end hosts";

key name;

leaf name {

description "Name of the l2-edge service";

type string;

}

leaf description {

description "Description of the user of the service (port description)";

type string;

}

container devices {

description "Devices that should form an l2-edge service.";

list device {

description "Device the port should be configured on.";

key name;

unique "device-id interface-name";

leaf name {

type string;

}

leaf device-id {
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type leafref {

path "/ac:devices/ac:device/ac:id";

}

}

leaf unit {

type uint32;

description

"unit value";

n-ext:maps-to "/jcr:configuration/jci:interfaces/jci:interface/jci:unit/jci:name"{

s-ext:device-platform "JUNOS";

}

}

leaf variant {

type enumeration {

enum "trunk";

enum "access";

}

default "trunk";

n-ext:non-updatable;

n-ext:maps-to
"/jcr:configuration/jci:interfaces/interface[jci:name=current()/../interface-name]/unit[jci:name=current()
/../unit]/family/ethernet-switching/port-mode"{

s-ext:device-platform "JUNOS";

}

n-ext:maps-to
"/jcr:configuration/jci:interfaces/interface[jci:name=current()/../port-channel-id]/unit[jci:name=current()
/../unit]/family/ethernet-switching/port-mode"{

s-ext:device-platform "JUNOS";

}

}

leaf interface-name {

description "Interface for the l2-edge service";

type string {

n-ext:atom-leafref-path
"/ac:devices/ac:device[ac:id=current()/../device-id]/jcr:configuration/jci:interfaces/jci:interface/jci:name"
;

}

mandatory true;

n-ext:maps-to "/jcr:configuration/jci:interfaces/interface/name"{

s-ext:device-platform "JUNOS";
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}

n-ext:ncx-add-reference-false;

}

must
'(count(/ac:services/l2edge:l2-edge/devices/device[device-id=current()/device-id]/interface-name[interfa
ce-name=current()/interface-name]) < 2)' {

error-message "Interface Name already used";

}

leaf native-vlan {

description "Native VLAN that is configured when trunk ports are used";

type int16 {

range 1..4094;

}

mandatory true;

when "../variant = 'trunk'";

n-ext:maps-to "/jcr:configuration/jcv:vlans/vlan/vlan-id"{

s-ext:device-platform "JUNOS";

}

n-ext:ncx-maps-to-expr "/jcr:configuration/jcv:vlans/vlan/name = Vlancurrent()"{

s-ext:device-platform "JUNOS";

}

n-ext:maps-to
"/jcr:configuration/jci:interfaces/interface/unit/family/ethernet-switching/native-vlan-id"{

s-ext:device-platform "JUNOS";

}

}

container vlans {

description "List of vlans permitted on the l2-edge ports";

leaf-list vlan-id {

type int16 {

range 2..4094;

}

min-elements 1;

n-ext:maps-to "/jcr:configuration/jcv:vlans/vlan/vlan-id"{

s-ext:device-platform "JUNOS";

}

n-ext:ncx-maps-to-expr "/jcr:configuration/jcv:vlans/vlan/name = Vlancurrent()"{

s-ext:device-platform "JUNOS";

}
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}

must
'(count(/ac:services/l2edge:l2-edge[name=current()/../../../name]/devices/device[name=current()/../na
me]/vlans/vlan-id) = 1 and ../variant = "access") or
(count(/ac:services/l2edge:l2-edge[name=current()/../../../name]/devices/device[name=current()/../nam
e]/vlans/vlan-id) >= 1 and ../variant = "trunk")' {

error-message "vlan should be one if variant is access or vlan should be >= one if variant is
trunk";

}

}

}

}

}

}

}

4. Using ATOM sdk plugin task generate the service package code for l2edge.yang as below.

Change to current directory i.e. the service  package directory & run the commands

gradle tasks --all (this will display all the tasks )

gradle generateServicePackage(Runs the ServicePackage generate task )

5. Now the scripts folder has the auto-generated code. This code will have device mapping
code as well since the yang has mappings between service leafs and device model leafs
using maps-to statement.

6. Now we need to generate pybinds specific to device mappings:

gradle gDPB

7. Change to the current directory, i.e., servicepackage and run:

gradle archive

8. Uploading l2edge service package zip to ATOM

Navigate to Administration > Plugins & Extensions > Packages > Add
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On successful upload of the package, the following is displayed on the screen:

8. To Activate the l2edge package by selecting from list of packages using search box as
below

After entering ‘l2edge’ key in search box hit the enter button to get the result

Select the package and hit Activate button

After Active Package completion, notice Active state changed to true.
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9. Check package python load status in the service model plugin

Navigate to Administration > Troubleshoot > Services & Metrics > Servers >
Components > Parent-Name: Python > ServiceModel Plugin

To Check the l2edge package loaded properly or not, select ServiceModel Plugin and
Click on Statistics will show the list of packages loaded into ATOM as below.

10. Creating the l2edge through ATOM

Navigate to Automation > Services

In the Catalog pane, click the l2edge:l2-edge > click + to add the l2edge.
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In the Create l2edge, fill the values in the properties displayed in the form:

Click ✅ to instantiate the service.

To track the service, Go to Administration -> Tasks and Events and find for the tasks
created:

To view the commands generated for this service, click the view button
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Exercise: L3 Service Service Modeling
This section describes the procedure for creating service package for a L3 service (in this
example, l3service.yang is modelled to configure an interface either as l3/sub/vlan and make it
part of a vrf and assign IP)

1. Extract the provided atomsdk zip and create a service package environment by selecting
the option of type SERVICE_MODEL and package name as l3service as per Creating a
Package using SDK.
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2. Create l3service.yang under src/main/model
3. Put below content in l3service.yang

module l3service {

namespace "http://anutanetworks.com/l3service";

prefix l3service;

import ietf-inet-types {

prefix inet;

}

import ncx-extensions {

prefix n-ext;

}

import sdk-extensions {

prefix s-ext;

}

import controller {

prefix ac;

}

import interface {

prefix ai;

}

import l2features {

prefix l2;

}

import l3features {

prefix l3;

}

import ncx-types {

prefix nt;

}

organization

"Anuta Networks";

revision 2014-07-01 {

description

"Initial revision";
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}

typedef interface-mode-type {

type enumeration {

enum "sub-interface";

enum "l3-interface";

enum "vlan";

}

}

grouping l3service {

leaf service-status {

type string;

description

"string";

config false;

default "AVAILABLE";

}

leaf name {

type string;

description

"string";

mandatory true;

}

leaf device-id {

type leafref {

path "/ac:devices/ac:device/ac:id";

}

description

"device-id";

mandatory true;

}

leaf interface-mode {

type interface-mode-type;

description

"sub-interface

l3-interface

vlan
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";

mandatory true;

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/interface[long-name=current()/../interfa
ce]/mode";

}

leaf interface {

type leafref {

path "/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/ai:interface/ai:long-name";

}

description

"interface";

when "../interface-mode = 'sub-interface' or ../interface-mode = 'l3-interface' ";

n-ext:ncx-maps-to-expr "/ac:devices/device/ai:interfaces/interface/long-name = current()";

n-ext:ncx-maps-to-expr "/ac:devices/device/ai:interfaces/interface/name = current()";

s-ext:ncx-maps-to-expr-when "../interface-mode = 'l3-interface'";

n-ext:ncx-add-reference-when "../interface-mode = 'sub-interface' or ../interface-mode = 'vlan'";

n-ext:non-updatable;

}

leaf description {

type string;

description

"string";

n-ext:maps-to "/ac:devices/ac:device[ac:id=current()/../device-id]/l2:vlans/l2:vlan/l2:name";

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/interface[long-name=current()/../interfa
ce]/description";

}

leaf vrf {

type string;

description

"string";

n-ext:maps-to "/ac:devices/ac:device[ac:id=current()/../device-id]/l3:vrfs/l3:vrf/l3:name";

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/interface[long-name=current()/../interfa
ce]/vrf";

}

leaf vlan-id {

type uint32 {

range "1..4096";
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}

description

"1..4096";

mandatory true;

n-ext:maps-to "/ac:devices/ac:device[ac:id=current()/../device-id]/l2:vlans/l2:vlan/l2:id";

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/interface[long-name=current()/../interfa
ce]/vlan";

when "../interface-mode = 'sub-interface' or ../interface-mode = 'vlan' ";

n-ext:ncx-maps-to-expr "/ac:devices/device/ai:interfaces/interface/long-name = Vlan+current()";

n-ext:ncx-maps-to-expr "/ac:devices/device/ai:interfaces/interface/name = Vlan+current()";

s-ext:ncx-maps-to-expr-when "../interface-mode = 'vlan'";

}

leaf ip-address {

type inet:ipv4-address;

description

"Valid IPv4 Address (A.B.C.D for e.x: 172.16.1.1)";

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/interface[long-name=current()/../interfa
ce]/ip-address";

}

leaf netmask {

type inet:ipv4-address;

description

"Valid IPv4 Address (A.B.C.D for e.x: 172.16.1.1)";

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/interface[long-name=current()/../interfa
ce]/netmask";

}

leaf ipv6-address {

type inet:ipv6-address;

description

"Valid IPv6 Address (X::Y for e.x: 2001::1)";

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/interface[long-name=current()/../interfa
ce]/ipv6-address";

}

leaf ipv6-prefix-length {

type nt:ipv6-prefix-length;

description

"IPv6 netmask in CIDR notation.";
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n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/interface[long-name=current()/../interfa
ce]/ipv6-prefix-length";

}

leaf vrf-definition-mode {

type boolean;

description

"vrf-definition-mode: True/False";

default "true";

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/ai:interfaces/interface[long-name=current()/../interfa
ce]/vrf-definition-mode";

n-ext:maps-to
"/ac:devices/ac:device[ac:id=current()/../device-id]/l3:vrfs/l3:vrf[name=current()/../vrf]/l3:vrf-definition-
mode";

config false;

}

}

augment "/ac:services" {

container l3-services {

list l3-service {

n-ext:ncx-service;

key "name";

n-ext:ncx-maps-to-expr "/ac:devices/device/ai:interfaces/interface/long-name =
$(interface).$(vlan-id)";

n-ext:ncx-maps-to-expr "/ac:devices/device/ai:interfaces/interface/name = $(interface).$(vlan-id)";

s-ext:ncx-maps-to-expr-when "../interface-mode = 'sub-interface'";

uses l3service:l3service;

}

}

}

}

5. Using ATOM sdk plugin task generate the service package code for l3service.yang as
below

Change to current directory i.e. the service  package directory & run the commands

gradle tasks --all (this will display all the tasks )

gradle generateServicePackage(Runs the ServicePackage generate task )
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9. Now the scripts folder has the auto-generated code. This code will have device mapping
code as well since the yang has mappings between service leafs and device model leafs
using maps-to statement.

10. Change to the current directory, i.e., servicepackage and run:

gradle archive

7. Uploading l3service service package zip to ATOM

Navigate to Administration > Plugins & Extensions > Packages > Add

On successful upload of the package, the following is displayed on the screen:

9. To Activate the l3service package by selecting from the list of packages using search box
as below.After entering ‘l3service’ or ‘l3’ key in search box hit the enter button to give
the result and Select the package and hit the Activate button.
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After Active Package completion, notice Active state changed to true.

10. Check package python load status in the service model plugin

Navigate to Administration > Troubleshoot > Services & Metrics > Servers >
Components > Parent-Name: Python > ServiceModel Plugin

To Check the l3service package loaded properly or not, select ServiceModel Plugin and
Click on Statistics will show the list of packages loaded into ATOM as below.
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11. Creating the l3service through ATOM

Navigate to Automation > Services

In the Details pane, click the L3service icon > click Add L3service.

In the Create l3service pane, fill the values in the properties displayed in the form:

Click OK to instantiate the service.
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To track the service, Go to Administration -> Tasks and Events and find for the tasks
created:

To view the commands generated for this service, click the view button
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Appendix

ATOM Schema Browser
Using the Schema Browser, you can browse the YANG schema (object tree) to derive the relative
path for the modelled entities in ATOM. Using this utility, you can look at all the ATOM entities
that have been modelled in YANG. Apart from the schema structure of the individual entities,
you can also view the schema of any device or service package that is activated in ATOM.

Example
In this example, let us explore how the schema for VRFs
/controller:devices/device/l3features:vrfs can be obtained using the Schema Browser..

1. Go to Administration > System > General settings. Select the Enable-Developer-Mode.
2. Navigate to Developer Tools > Schema Browser

3. In the text box, type /controller:
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4. By typing the keyword devi in Schema Path (/controller:devi), all the entities starting
with that start with devi as shown below:

5. As devices container is modeled under controller, xpath to fetch the devices schema
present in ATOM is /controller:devices
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6. Hit the Enter button to get the devices schema

The schema path for the VRFs: /controller:devices/device/l3features:vrfs/vrf
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ATOM Extensions to YANG
Anuta Networks developed its own custom extensions to enhance the usage of YANG and these
extensions are located in the following folders:

atomsdk/packages/Anuta/anuta/ncx/ncx-extensions.yang

atomsdk/packages/Anuta/anuta/ncx/ncx-ui-extensions.yang

atomsdk/packages/abstractdevicemodels/model/sdk-extensions.yang

Some of the commonly used UI extensions in ATOM are listed below:

1. ncx-ext-seq-no: This extension is used to indicate the display order of the property in the
ATOM UI.

E..g:
leaf cpu-mhz {

type uint32;
n-ext-ui:ncx-ext-seq-no 56;

}

2. ncx-ext-hidden: This extension can be used to hide a node from UI form.
3. ncx-ext-multi-select: This extension can be used to select multiple values in combobox.

Below are some of the extensions useful in service package code-generation and more can be
found in the above mentioned files.

1. maps-to: This extension is used to define a mapping between service data node to device
data node. The mapping can be an Xpath or RC path.
E.g:
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leaf auth-password {
type string {
length "1..8";

}
description
"string";

n-ext:maps-to "/controller:devices/device/if:interfaces/interface/hsrp:hsrp/auth-key";
}";

2. ncx-maps-to-expr: This extension is a superset of maps-to, we can write an expression
about how it maps element(s) in service yang to element in device yang.
E.g:

list endpoints {
n-ext:ncx-maps-to-expr '/ac:devices/device/ai:interfaces/interface/long-name' =

'$(interface-name).$(unit)';
leaf unit {
type uint8;

}
leaf interface-name {
type string;

}
}

3. device-platform: Use this extension as a sub-statement of maps-to for specifying the
platform to which this maps-to is applicable for.
E.g:

leaf native-vlan-id {
type uint16 {

range "1..4094";
}

mandatory true;
when "../variant = 'trunk'";
n-ext:maps-to

“/ac:devices/ac:device[ac:id=current()/../switch1-device-id]/if:interfaces/interface/allowed-vlans/if-ext:nativ
e-vlan"{

sdk-ext:device-platform "JUNOS";
}

}

YANG Validations & Constraints
Below are few yang statements which will help to build intelligence(validations/
checks/constraints) in the model

1. when

Nodes are valid only if the when condition is satisfied.

E.g:
leaf variant {

type enumeration {

enum "trunk";

enum "access";
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}

}

leaf native-vlan {

description "Native VLAN that is configured when trunk ports are used";

type int16 {

range 1..4094;

}

when "../variant = 'trunk'";

}

In the above example native-vlan will be used only if variant = trunk.

2. must

It can be used on any data to have some constraints

E.g:
leaf variant {

type enumeration {

enum "trunk";

enum "access";

}

}

container vlans {

description "List of vlans permitted on the l2-edge ports";

list vlan {

key vlan-id;

leaf vlan-id {

type int16 {

range 2..4094;

}

}

must
'(count(/ac:services/l2-edge:l2edge[name=current()/../../../../name]/devices/device[name=current()/../../nam
e]/vlans/vlan/id) = 1 and ../../variant = "access") or
(count(/ac:services/l2-edge:l2edge[name=current()/../../../../name]/devices/device[name=current()/../../name
]/vlans/vlan/id) >= 1 and ../../variant = "trunk")' {

error-message "vlan should be one if variant is access or vlan should be >= one if variant is trunk";

}

}

}

Above must is used to validate vlan count to be exactly 1 if the variant is access or
vlan count to be >=1 if variant is trunk
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Library Utils for Service Modelling
For service modeling development Anuta provides library utils which are accessible at
atomsdk/packages/servicemodel/scripts. These can be used in python based service logic
written either manually or auto generated via SDK.

The python classes generated for the device yang models (Python Bindings for Device YANG
Models) will also be present in the above directory which effectively makes the servicemodel
package as a complete library for usage in service python logic.

servicemodel/scripts/device_abs_lib.py consists of various definitions which are basic CRUD
operations performed on an object.

● create()- To create the object in ATOM using post operation
● update()- To edit the object in ATOM using put operation (overwrite)
● delete()- To delete the object in ATOM using delete operation.

The other definition validate_inputs_form_payload in this file will use the python bindings
present in servicemodel/scripts/controller to validate the inputs and form the payload required
for above CRUD operations.

Few other commonly used python modules in servicemodel/scripts are

1. yang.py
2. util.py
3. devicemgr.py

1. yang.py provides Sdk class and AbstractYangServiceHandler class

Sdk Class provides basic methods to do CRUD operations for service models.

● createData()- To create the object to ATOM using post operation

● updateData()- To edit the object of ATOM using put operation (overwrite)

● patchData()- To patch the object of ATOM using patch operation(extension)

● getData()- To get the object of ATOM using get operation

● deleteData()- To delete the object of ATOM using delete operation.

These methods are used for modeled entities only, not for RPC’s. To deal with RPC’s Sdk Class

provides invokeRpc() method

CreateData Method

createData() method takes inputs as url, payload, yang_session, addReference and

failOnExistingData arguments and posts the data to the server.

● url : target on which data to be posted

● payload: xml/json object to be posted

● yang_session: session object

● addReference: If AddReference is True, ATOM will create a reference for this object to

keep track of this object.
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Note: if addReference is True, no need to handle delete block for this object, as ATOM platform

will take care of deletion of this object using reference.

@staticmethod

@util.wrappedmethod()

def createData(url, payload, yang_session, addReference=True, failOnExistingData=False):

if payload == "" or payload is None:

util.log_debug('payload is empty or none')

return

try:

from com.anuta.model.base import YangSessionThreadLocal

except ImportError:

pass

YangSessionThreadLocal.setDeviceAuditDisabled(True)

try:

Sdk.createDataWithTaskId(url, payload, yang_session, yang_session.getTaskId(), addReference,

failOnExistingData)

finally:

YangSessionThreadLocal.setDeviceAuditDisabled(False)

Example

In this example, addReference is True by default as it is not mentioned, So for this entity no

need to handle delete code in service logic

uri = '%s/vrf=%s/router-bgp' % (dev.url, vrf_name)

print 'uri = %s, neighbor = %s' % (uri, neighbor.toXml())

yang.Sdk.createData(uri, neighbor.toXml(), ctx.getSession())

Similarly we have updateData, patchData and deleteData Methods in this Sdk class. Please refer

yang.py module for more details in atomsdk/packages/servicemodel/scripts

invokeRpc() Method

This method takes inputs as rpcname and payload and provide respective output

● rpcname: Name of the rpc
● payload: payload object in xml/json

@staticmethod
# @util.wrappedmethod(detailed_log=True)
def invokeRpc(rpcname, payload, log = True):
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if log:
util.log_debug('rpcname = %s, payload = %s' % (rpcname, payload))

# FIXME: remove this in 5.7
origTaskId = YangSessionThreadLocal.getTaskId()
try:

ret = Sdk.getInstance().restconf.invokeRpc(rpcname, payload)
finally:

YangSessionThreadLocal.setTaskId(origTaskId)
return ret

If any entity in ATOM is not modeled then we can implement RPC for the entity and call when
we require in service modeling using this method.

Example

In this example rpc-name is device-discovery and the payload we are forming with the help of
kwargs dictionary, finally we will get output_xml object when invokeRpc is called.

def sl_device_discovery(**kwargs):
slinput = sciencelogic_rpc.device_discovery.input.input()
slinput.cidn = kwargs.get('cidn')
slinput.source_system = kwargs.get('source_system')
slinput.community  = kwargs.get('community')
slinput.device_id = kwargs.get('device_id')
slinput.collector = kwargs.get('collector')
slinput.template = kwargs.get('template')
if isinstance (kwargs.get('device_ip'), list):
for devip in kwargs.get('device_ip'):
sldips = slinput.device_ips.add(devip)

else:
sldips = slinput.device_ips.add(kwargs.get('device_ip'))

payload = slinput.getxml(filter=True)
log("create payload is:%s", payload)
output_xml = yang.Sdk.invokeRpc('sciencelogic:device-discovery', payload)
print "output_xml",output_xml
return output_xml

AbstractYangServiceHandler class provide two basic methods

● register() Method: Register all the resource unit handlers. This method is called from the
plugin.py module of the service package.

def register(self):
""" Register all resource unit handlers. This is called from the plugin code
when the plugin is started
"""
for xpath in self.handler_map.keys():

handler = self.handler_map[xpath]
util.log_debug('Registering %s => %s' % (xpath, handler))
registerServiceHandler(xpath, handler)

This register method internally calls registerServiceHandler() class for details refer
yang.py module

● unregister() Method: Unregister all the resource unit handlers. This method is called
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from the plugin.py module of the service package when unloading packages done from
ATOM.

def unregister(self):
""" Unregister all resource unit handlers. This is called from the plugin code
when the plugin is stopped
"""
for xpath in self.handler_map.keys():

handler = self.handler_map[xpath]
unregisterServiceHandler(xpath, self.global_map)

This unregister method internally calls unregisterServiceHandler() class, for details refer
yang.py module

2. util.py provides utilities for service model development with the help of IPPrefix class and
some other functions

IPPrefix class takes cidr as input and provides details about address, netmask and wild card etc.,
as output.

class IPPrefix(object):

""" IP Prefix utility class
"""
def __init__(self, prefix):

self.prefix = prefix
arr = prefix.split('/')
if len(arr) > 1:

self.address = arr[0]
self.masklen = int(arr[1])
mask = IPPrefix.get_mask_num(self.masklen)
self.netmask = IPPrefix.to_ip_address(mask)
self.wildcard = IPPrefix.to_ip_address(~mask)
# FIXME: handle ipv6
if self.masklen == 32:

self.is_ipaddress = True
else:

self.is_ipaddress = False
else:

self.address = prefix
self.netmask = '255.255.255.255'
self.wildcard = '0.0.0.0'
self.masklen = 32
mask = ~0
self.is_ipaddress = True

# convert address to number
addrnum = IPPrefix.ip2int(self.address) & mask
self.network = IPPrefix.to_ip_address(addrnum)

Example of IPPrefix

In this example IPPrefix class takes cidr as input and provides netmask as output
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cidr_obj = util.IPPrefix(inputdict['cidr'])
dest_mask = cidr_obj.netmask

Few frequently used methods in Module util.py are:

● isEmpty() - This will check if the object is empty or not. Code Snippet for isEmpty()
Method

def isEmpty(val):
""" Check weather val is empty

Args:
Val : Value need to check
Returns:
True: if the value is empty
False: if the value is not empty
"""
if(val == None):

return True
if isinstance(val, list):

return len(val) == 0
if Collection.isInstance(val):

return val.isEmpty()
if isinstance(val, str):

return val.strip() == ''
if isinstance(val, unicode):

return str(val).strip() == ''

return False

Example for isEmpty():

In this example checking if protocol is empty or not, if empty then we are return from
there

def validate_protocol(self, ctx, protocol):
if util.isEmpty(protocol):

return

● isNotEmpty() - This will check if the object is not empty or not. Code Snippet for
isNotEmpty() Method
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def isNotEmpty(val):
""" Check weather val is not empty

Args:
Val : Value need to check
Returns:
True: if the value is not empty
False: if the value is empty
"""
if isEmpty(val):

return False
return True

Example for isNotEmpty():

This example checks inputdict[‘name’] is not empty and then only proceeds further

#Start of Device binding with python bindings

interfaces_object = devices.device.interfaces.interfaces()

if util.isNotEmpty(inputdict['name']):

interfaces_interface_object = interfaces_object.interface.add(long_name=inputdict['name'])

interfaces_interface_object.name = inputdict['name']

3. devicemgr.py provides basic methods to get device obj from device ip or device id or device
name etc.,

getDeviceByIp() Method

takes input as device management ip and provide device object to service model

Code Snippet for getDeviceByIp() Method:

def getDeviceByIp(ipAddress,validate_type = False,task_id=None):
"""
fetch the device complete tree for given ip
Args: device ip
Return: device object which has device information
"""
rcpaths = yang.Sdk.getRcPathListForXPathAndValue(

'/controller:devices/device/mgmt-ip-address', ipAddress)
if util.isEmpty(rcpaths):

util.log_debug('rcpaths for this device = %s are empty' %(ipAddress))
return None

rcPath = rcpaths[0]
if len(rcpaths) > 1:

util.log_debug('WARN: got multiple rcpaths. count = %d' % (len(rcpaths)))
util.log_debug('%s' % (rcpaths))

xml = yang.Sdk.getData(rcPath, '', task_id, None)
# util.log_debug('devicexml = %s' % (xml))
if(xml == None):
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util.log_debug('No xml data. rcPath = %s' % (rcPath))
return None

xmlObj = util.parseXmlString(xml)
dev = Device(xmlObj)

if validate_type and util.isEmpty(dev.device.get_field_value('device_type')):
raise Exception('Device type is empty for %s' % (ipAddress))

return dev

Example

In this example getDeviceByIp() method takes input as ip(device-management-ip) and provides
device_object for further actions

Note: If dev object is None then need to check whether device is onboarded or not (or) device is
online or not.

def create(self, ip, os_type, sdata):
print 'create ip = %s, ostype = %s' % (ip, os_type)
dev = devicemgr.getDeviceByIp(ip)
if(dev == None):

print 'No device by ip: %s' % (ip)
raise Exception('No device by ip: %s' % (ip))

Similarly we have few other frequently used methods

getDeviceById() method

getDeviceByName() method

getDeviceByUniqueName() method

getDeviceByInterfaceName() method

Please refer devicemgr.py module for more details at build/lib/servicemodel/scripts
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ATOM SDK
Introduction
ATOM Software Development Kit (SDK) provides a gradle-based plugin Package-Plugin jar that
serves as a backbone for package development in ATOM. ATOM SDK provides CLI and also
integration into IDE like IntelliJ. The plugin enables you to perform the following tasks of
Services/Drivers Development process in ATOM:

● Develop device packages
● Develop service packages
● Compile, validate, generate device and service packages
● Load Packages to ATOM
● Upgrade of Packages

Folder hierarchy
Unzip the contents of the ATOM SDK zip to view the following folder structure:.
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● doc - This folder contains README and the plugin documentation.
● examples - This folder has package zip files for different types of packages.
● packages - The core Package Plugin jar is part of the packages folder, which also has a

few more library and base dependency packages required for development of new
device and service packages.

● create.py, sdk.py, setup.py - These are the python files required for setting up device and
service packages environment.

Setting up the environment for ATOM Package
Plugin
ATOM Package Plugin supports multiple gradle tasks that help create an environment suited for
developing packages. These tasks can be triggered from an IDE or CLI.

For the plugin tasks to run, ensure that the prerequisites are met with.

Prerequisites
To setup the environment, you must ensure that the following software requirements are met:

1. Python (2.7.12)
2. Python setup tools
3. Python Pip and Python modules bitarray, cmd2, TAPI, XEGER
4. Pyang(1.7.8). Refer Appendix section for the details of pyang installation.
5. JAVA (java 1.8 or greater)
6. Gradle

For information about installing gradle in your environment, visit http://gradle.org.

Setting up the environment in Ubuntu
1. Execute the following commands:

sudo apt-get install python python-setuptools
sudo easy_install pip
sudo pip install bitarray
sudo pip install cmd2
sudo pip install tapi
sudo pip install xeger
sudo pip install requests

2. Install Oracle JDK for Linux and unzip it.

Set the JAVA_HOME environment variable pointing to  jdk   directory.

3. Install gradle by executing the following command:

sudo apt-get install gradle

Setting up the environment in Windows
1. Download  get-pip.py   from  https://bootstrap.pypa.io/get-pip.py
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2. Execute the following command:  python get-pip.py
3. Install Visual C++: https://www.microsoft.com/en-us/download/details.aspx?id=44266
4. Execute the following commands in the following order:

pip install setuptools --upgrade

pip install bitarray

pip install cmd2

pip install tapi

pip install xeger

pip install requests

5. Set the JAVA_HOME environment variable pointing to  jdk   directory.

Example: C:\Program Files\Java\jdk1.8.0_91

NOTE: Proper installation of gradle can be verified by using the command
gradle -version.

6 . Gradle Installation in windows

Step 1. https://gradle.org/releases/ get the latest Gradle distribution

Step 2. Unpack the distribution zip

Step 3. Configure your system environment Path variable

For e.x: C:\Gradle\gradle-4.10.2\bin.

Step 4. Verify your installation

Open a console (or a Windows command prompt) and run gradle -v to run gradle and
verify the version, e.g.:

$ gradle -v

-----------------------------------------------------------------

Gradle 4.10.2

Setting up the repository for developing packages
In ATOM SDK, the sdk.py script sets up the SDK plugin environment for creating various
packages.

To setup the repository of your choice, follow the steps as outlined below:

66

https://www.microsoft.com/en-us/download/details.aspx?id=44266
https://gradle.org/releases/


1. Run the command: python sdk.py -s

This command runs the setup.py script which setups an environment for packages
repository.

setup.py - This script is used to setup repositories for core-dependent packages. The
core-dependent packages are present inside the “packages” folder and are necessary for
developing new device and service packages.

2. Select the repository of your choice.

You can either setup a local repository or can publish the core-dependent packages to an
artifact repository such as Nexus.

● Local Repository (Flat Directory Structure) : This option enables you to copy the
core-dependent packages present in the “packages” folder to a flat directory.

● The absolute path of this particular flat directory, for example, ‘/home/’ as shown
below(verify that this folder is present already)

● Maven Artifact Repository : This option enables the user to copy the core-dependent
packages in the “packages” folder uploaded to the artifact repository, for example
Nexus.
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After setting up the repository, the script generates a config.xml file. This file contains
two tags:

a) repo-type : Maven or Flat Directory
b) repo-path : The absolute path or URL of the directory.

The metadata present in the config.xml is important to run the subsequent scripts.

Let us take the example of the selected repository as the Flat Directory(a local repository) and
the steps to be followed are illustrated below:

1. Enter the IP address of ATOM

If port is required for accessing the ATOM application then mention that as well. E.g:
172.16.1.10:30443, 127.0.0.1:8890

2. Enter the credentials to login into ATOM
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After the successful setup process, the following files and folders are generated

● global.properties - contains the username, password and ATOM ip which will be used in
package development process

● config.xml - contains the information of repo-type and path to dependencies.
● dependencies - The dependency packages for development of device and service

models are copied to the destination folder of your choice.

IMPORTANT: Do not delete these files or folders.

Tasks for developing packages
ATOM package plugin internally uses gradle for providing various options in package
development.

General Gradle tasks

Command Description

grade -help All the commands are listed here

gradle tasks --all All the gradle tasks are listed here
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gradle  -help

All the commands can be viewed as shown below:

gradle tasks --all

Execute this command at root level as shown below:

Execution of these commands at the package level displays all the tasks that are available in the
plugin, Build, Documentation
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ATOM specific tasks
Few of the Important Gradle Tasks, specific to ATOM, along with their descriptions are listed
below:

Task Description Modeling
Relevance

generateYin This task is used to convert a YANG file to
a YIN equivalent. The generateYin task
internally uses python's PYANG tool
which has been modified to support
validating of the ATOM YANG models.

Device & Service
Modelling

generateDeviceOperationTe
mplate

This task generates the
deviceoperation.xml file containing the
details of the create, delete, and update
operations.

Device Modelling

verifyDeviceOperations This task is used to verify the device
operations defined for a device yang
model. It creates a file that consists of
warning statements of invalid device
operation yang Xpath targets.

Device Modelling

generateDevicePackage This task is used to generate device
packages for a given device.yang being
developed.

Device Modelling

generatePyBinds This task is used to generate python class
hierarchy for a YANG data model and its
dependencies.

Device Modelling

generateDeviceDriverPacka
ge

This task is used to generate a device
driver package for a given
device-driver-yang being developed.

Device Modelling

generateServicePackage This task is used to generate a service
package for a given service.yang being
developed.

Service Modelling

generateDevicePybinds This task is used to generate python class
hierarchy for a YANG data model and its
dependencies in a service package.

Service Modelling
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Load This task is used to upload a package to
an ATOM instance.

Device & Service
Modelling

Activate This task is used to activate a package
present in an ATOM instance.

Device & Service
Modelling

Deactivate This task is used to deactivate a package
loaded in an ATOM instance.

Device & Service
Modelling

Delete This task is used to delete a package
present in an ATOM instance.

Device & Service
Modelling

Upgrade This task is used to upgrade an already
existing package present in an ATOM
instance.

Device & Service
Modelling

Replace Replace a package with new package
content without any manual package
upgrade steps

Device & Service
Modelling

Purge Clean all/specific data and its reference
data under the package

Device & Service
Modelling

cleanBuild This task is a combination of two gradle
tasks,  ‘clean’ and ‘ build
--refresh-dependencies’. This task first
executes gradle clean. The clean task is
defined by the java plugin and it removes
the buildDir folder, thus cleaning previous
builds’ artifacts,  which are no longer
relevant.

Device & Service
Modelling

copyToDependencies This task internally runs the archive task
(which generates the
ready-to-be-uploadable zip). After
generating the zip, it ascertains the
repository type (whether maven/local)
from config.xml file and the repository
path.

Device & Service
Modelling

enableMaintenanceMode This task is used to enable maintenance
mode on an ATOM instance. To run this
task make sure all the necessary
modifications are made in
gradle.properties file, that have been
explained in the load task.

Device & Service
Modelling
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disableMaintenanceMode This task is used to disable maintenance
mode on an ATOM instance. To run this
task, ensure that all the necessary
modifications are made in
gradle.properties file, explained in the
load task.

Device & Service
Modelling

restartServiceModelPlugin
Agent

This gradle task is used to stop and restart
service model plugin for the agent.

Device & Service
Modelling

restartServiceModelPluginS
erver

This gradle task is used to stop and restart
service model plugin for server.

Device & Service
Modelling

Below is a bit more detailed explanation of Gradle Tasks useful in Service Modelling.

generateYin

1. Before running this task, ensure that the YANG model of the package is available in the
path: src\main\model.

2. The generated yin file is created in the build\generated directory.

In the gradle.properties file, if the overwrite flag is set to ‘true’, the result is generated in
the folder, usermodel\src\main, where ‘usermodel’ is the name of the package created.

If this flag is set to ‘false’, the file is generated in the path usermodel\build\generated
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generateServicePackage

The service package generated contains the following entities:

1. The model folder contains the following:
<service_name>.yang file - Contains the schema of the service defined in YANG. This
yang will be taken as input for the task to generate a service package basic service
logic files.

2. The scripts folder contains the following files:
● <service_name>.py - Contains the logic binding the service to the device.
● plugin.py - Code for adding the service as a new plug-in to ATOM
● _init_.py - Required to make ATOM treat the directories as containing

packages

If gradle.properties file autoupdate flag is set to true, it won’t generate updates and delete
pieces of code, whereas ATOM platform will handle it automatically.

If the driverimport flag is set to true it will take the driver name as the import for pybinds.

If gradle.properties file overwrite flag is set to false, the result is generated in path
servicepackage/build/generated else it is generated in src/main as shown below:
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generateDevicePyBinds
By performing this task on device models of ATOM, the resulting python classes allow
additional methods to be associated with the service modelling.

This generates with <devicedrivername> named library package which has python classes
for the YANG data models mentioned as dependency.

Load

This task is used to upload a package to an ATOM instance.

Before uploading the package to ATOM, make sure the parameter values in the
gradle.properties file are as per ATOM instance you use.
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1. atomHost property should be provided with a valid IP address.
If a port needs to be included for accessing applications. Then include that as well. E.g:
https://172.16.16.177:30443

2. authToken should be provided.
AuthToken is used for basic authorization. The format of the authtoken is, the keyword
Basic followed by base64 encoding of the string <username>:<password>”, as shown
above. These are the default values that can be updated as required.

Upon Load gradle task being successful, the desired changes can be observed in the ATOM UI.
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Activate

This task is used to activate a package available in an ATOM instance. To activate a package,
ensure the gradle.properties file has the aforementioned properties (mentioned in load task).
This task changes the active flag of a package to ‘true’ in ATOM. Upon success, the desired
changes can be observed in the ATOM UI.
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Deactivate

This task is used to deactivate a package loaded in an ATOM instance. To deactivate a package
ensure that the gradle.properties file has the aforementioned properties (mentioned in load
task). This task changes the active flag of a package to ‘false’.

Upon success, the desired changes can be observed in the ATOM UI.
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Delete

This task is used to delete a package from an ATOM instance.

Upon success, the desired changes can be observed in the ATOM UI.

Upgrade

This task is used to upgrade an already existing package present in an ATOM instance. To
upgrade a package ensure that the gradle.properties file has the properties mentioned in the
load task. The ‘to be upgraded’ package should have a different version than the existing
package in ATOM.
The version of the package can be changed in the build.gradle file as shown below.
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Version being changed to ‘7.0.1.0’ from ‘7.0.0.0’
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On completion of the upgrade task, the latest version of the package is updated to ‘Active: true’
and the older version of the same package is set to ‘Active:False’ as shown below:

cleanBuild
This task is a combination of two gradle tasks, ‘clean’ and ‘build --refresh-dependencies’. This
task first executes gradle clean. The clean task is defined by the java plugin and it removes the
buildDir folder, thus cleaning previous builds’ artifacts, which are no longer relevant.

After cleaning, this task runs gradle build --refresh-dependencies.

81



The --refresh-dependencies option - Enables Gradle to ignore all cached entries for resolved
modules and artifacts. A fresh resolve will be performed against all configured repositories, with
dynamic versions recalculated, modules refreshed, and artifacts downloaded.

To run this task, enter: gradle cleanBuild

copyToDependencies
This task internally runs the archive task (which generates the ready-to-be-uploadable zip). After
generating the zip, it ascertains the repository type (whether maven/local) from config.xml file
and the repository path.

Based on the information gathered, it either publishes the artifact repository in case the
repository is maven or copies the dependencies to the local dependencies directory in case the
repository is flat Directory.

To run this task, enter: gradle copyToDependencies

Above task copied from usermodel zip into package dependency folder so that usermodel
package can serve as a dependency for any other package development.
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enableMaintenanceMode

This task is used to enable maintenance mode on an ATOM instance. To run this task make sure
all the necessary modifications are made in gradle.properties file, that have been explained in
the load task.

Upon success, the desired changes can be observed in the ATOM UI.

disableMaintenanceMode

This task is used to disable maintenance mode on an ATOM instance. To run this task , ensure
that all the necessary modifications are made in gradle.properties file, explained in the load
task.
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Upon success, the desired changes can be observed in the ATOM UI.

restartServiceModelPluginAgent
This gradle task is used to stop and restart service model plugin for the agent.

During the task execution, the desired changes can be observed in the ATOM UI.
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restartServiceModelPluginServer

This gradle task is used to stop and restart service model plugin for server.

Upon success, the desired changes can be observed in the ATOM Tasks UI.

Running ATOM Package Plugin Tasks
The ATOM Package Plugin gradle tasks available for package development as described in the
section, “Tasks for developing packages” can be executed from an  IDE (For reference, Intellij is
used as an IDE) or directly from the CLI as described below.

Running Tasks in IDE
1. Install Intellij from https://www.jetbrains.com/idea/download/
2. Select File > New > Project from existing sources.
3. To import the ATOM-package plugin into IntelliJ, select the build.gradle file from the

package being developed as discussed in Setting up ATOM Package Plugin Environment.
4. Select View > Tool windows > gradle

Gradle support is displayed on the right-hand side.

5. Select the "Tasks" list. Execute the following operations:

a) build >  clean

b) build

6. Run the ATOM plugin tasks based on your requirements as discussed in ATOM specific
tasks

Example: gradle generateYin
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Running Tasks in CLI
1. Follow the procedure as described in the section, “Setting up the repository for package

development”, locate the new package being developed and execute the following
commands:

gradlew build –refresh-dependencies (Windows)

./gradlew build –refresh-dependencies (Linux)

2. To view all the available tasks in gradle, enter the command: - gradle tasks --all
3. To clean the latest build, enter : gradle tasks clean
4. To build the project, enter: gradle tasks build
5. To run a required ATOM plugin task based on your requirement as discussed in ATOM

specific tasks, enter : gradle <task-name>

E.g: gradle genarateYin

Troubleshoot & FAQs - ATOM Localhost

Agent IPAddress not getting assigned
Check ATOM agent has a valid ip assigned or not. Navigate to Administration -> Troubleshoot ->
Node manager

If there is a missing Ip address, restart the nassagent. So check the status of docker container
using below cmd:
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docker ps -a | grep agent

Docker containers could still be in an unhealthy state, because of this ip address could not be
assigned. In such a case restart of naasagent can be done.

To Restart the naasagent:

Copy agent container id and run below commands:

docker exec -it 41dfc1116936 bash     (41dfc1116936 is the container agent id)

root@41dfc1116936:/# cd /var/log/naas/

root@41dfc1116936:/var/log/naas# monit restart naasagent

After this Start the container and see if the container agent’s status is healthy and a proper IP
address is assigned to the agent.

Useful Docker commands
Few of the commands listed below can be used in order to troubleshoot any docker issues

1) To remove corrupt docker images:

docker rmi image-id
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2) To restart docker containers:

docker-compose -f docker-compose.yaml up

3) To start/stop docker containers:

Start docker [container]

Stop docker [container]

4) To kill a particular container:

Docker kill [container]

5) To kill all the containers that are currently running:

docker kill $(docker ps -q)

6) To delete a particular container that is not currently running:

docker rm [container]

7) To delete all the containers that are not currently running.:

docker rm $(docker ps -a -q)

Steps to install docker and docker-compose
Following steps will install docker-ce, docker-compose, docker-machine on ubuntu 16.04
machine:

● sudo apt-get update
● sudo apt-get install apt-transport-https ca-certificates curl software-properties-common

vim
● curl -fsSL https://download.docker.com/linux/ubuntu/gpg | sudo apt-key add -
● sudo add-apt-repository \

"deb [arch=amd64] https://download.docker.com/linux/ubuntu \

$(lsb_release -cs) \

stable"

● sudo apt-get update
● sudo apt-get install docker-ce
● sudo usermod -aG docker $(whoami)
● sudo gedit /etc/docker/daemon.json

copy below content and save+close it.

{

"dns": [ "8.8.8.8"]

}

● sudo service docker restart
● sudo curl -L

88



https://github.com/docker/compose/releases/download/1.25.5/docker-compose-`unam
e -s`-`uname -m` -o /usr/local/bin/docker-compose

● sudo chmod +x /usr/local/bin/docker-compose
● sudo reboot

Above command will reboot your machine.

In case the output of “sudo service docker status” is shown as failed, check the logs using
cmd “sudo journalctl -r -n 100 -u docker.service”

Troubleshoot & FAQs - Service Modelling
Errors during package upload into ATOM
 Package Dependency Error

 Make sure all the packages mentioned in import statements of your service yang are present
in the ATOM already. Those dependency packages if not uploaded then ATOM will throw
package dependency Errors. For E.g in below snippet, make sure all import statements yang
files are present.

 

Example exception:

Upload: l3service:8.0.0.0 -
applicationyang-compilation-failedcompilation-failure/opt/naas/temp/1559629884671-0/schema/model/l3service.yang
Errors:
Failed to convert file l3service.yang
# read /data/naas/DevicePackages/Anuta/model/ncx-ui-component-state.yang
# READ /data/naas/DevicePackages/Anuta/model/ncx-ui-component-state.yang
# read /data/naas/DevicePackages/Anuta/model/interface.yang
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# READ /data/naas/DevicePackages/Anuta/model/interface.yang
# read /data/naas/DevicePackages/Anuta/model/if-type.yang
# READ /data/naas/DevicePackages/Anuta/model/if-type.yang
/opt/naas/temp/1559629884671-0/schema/model/l3service.yang:11: error: module "sdk-extensions" not found in search
path
/opt/naas/temp/1559629884671-0/schema/model/l3service.yang:20: error: module "l2features" not found in search path
/opt/naas/temp/1559629884671-0/schema/model/l3service.yang:20: warning: imported module l2features not used
/opt/naas/temp/1559629884671-0/schema/model/l3service.yang:23: error: module "l3features" not found in search path
/opt/naas/temp/1559629884671-0/schema/model/l3service.yang:23: warning: imported module l3features not used
/data/naas/DevicePackages/Anuta/model/ietf-netconf-acm@2012-02-22.yang:105: warning: the escape sequence "\*" is
unsafe in double quoted strings - pass the flag --lax-quote-checks to avoid this warning
/data/naas/DevicePackages/Anuta/model/ietf-netconf-acm@2012-02-22.yang:146: warning: the escape sequence "\*" is
unsafe in double quoted strings - pass the flag --lax-quote-checks to avoid this warning
/opt/naas/temp/1559629884671-0/schema/model/l3service.yang

Solution:

First upload and load all dependency packages, after that upload the service package.

Package Deletion Error
Users trying to delete the package from Administration > Plugins & Extensions > Packages, but
the services related to this package still exist in the Services tab, then the following exception
will be seen.
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Error: com.anuta.api.DataIntegrityException

Solution:
Ensure that the services instantiated using the service package are deleted. Before the deletion
of the service package, do the following:

1. Go to the Automation -> Services tab and delete all the services.

2. Navigate to the packages tab, Unload the package first and after that delete package.

91



Logging Level for Task Logs
Log_info or Log_debug statements can be added in python code to get those debug or info
messages in the Task Logs downloaded from ATOM.

E.x:

import util

util.log_info('calling register config provider for cisco')

util.log_debug("Exception seen with message: %s\n"%(str(e)))

Handler maps
To debug issues of python code whether it entered into each module or not, we need to check if
the required handler map is triggered or not. Handler map is to know which handles of service
code are getting triggered first when service is triggered. Generally these will be  present in
{module name}.py file (ex: suppose module name is acl_service, file in service package will be
with the name of Acl_Service.py).
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Verification In tasklog

Look for keyword After Sorting which shows what are the handles of service being invoked

Registering the Service Package with ATOM
After the service package is loaded successfully into ATOM, in the Services tab, user can check if
the python code with respect to yang is registered with ATOM or not. Users should cross check
like below.

1. Click Administration > Troubleshoot>Services & Metrics > Servers > Components >
Python > ServiceModelPlugin > click the Statistics tab

2. Check the status of the service package.
3. In the Statistics tab, if LOADED is displayed in the State column, the service package is

loaded into the ATOM system successfully.
4. If State column is FAILED for uploaded service package, then service package contains

some errors
5. Check for the exceptions in Service Model Plugin server log, fix the exception in

respective python module and upload again.
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Binding of the logic with ATOM
After uploading, registering the service package with ATOM successfully, syntactical and
semantic errors in the python glue logic can also cause issues that need to be resolved.

 Sample Failure to upload Python Plugin files

1. Navigate to the Task Viewer, download or view the Service Model Plugin logs and look for
the exception in the task log as shown below:
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Due to the hyphen (-) in the postscrub-vlan.py file, the package python code registering into
ATOM did not happen.

Exception:

2016-Apr-15 00:23:08.186 [http-bio-443-exec-73] !*f2861c70-2050-4488-b48a-e14173c43727*! ERROR
PythonPluginContainer.loadPythonPlugins(121) - SyntaxError: ("mismatched input '-' expecting IMPORT",
('<string>', 1, 14, 'from postscrub-vlan import plugin\n'))

Solution:

1. Rename the postscrub-vlan.py to postscrubvlan.py, similarly rename yang and yin files

Syntax Errors in Python plugin file

Error

Exception

SyntaxError: ("mismatched input '\\n' expecting COLON",
('/data/naas/OpenStackPlugins/postscrubvlan/aristaconfig.py', 84, 34, '      if self.ctx.switch1 !=
None \n'))

Solution:

Correct it like below
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Now service package is free of syntactical errors and is loaded successfully into ATOM

Semantic Errors in the Service package files
Even if the syntactically yang and python files are correct, there might be some issues due to
typos in the YANG files or URLs used in python, glue logic

Though these errors are not displayed in the log, check for the following:

1. The used URLs are appropriate
2. Typos in the yang files or python modules

Typo in Yang File

In glue logic, the path is described as shown in the following snippet:

Solution

Correct the typo present in yang and yin files
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Typos in Python Module

Defined in the YANG module is as shown below:
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Mismatch in the yang and python module due to typos leads to improper call invocation.

Solution

Correct the typos in the python module as shown below:

Commands not being generated in ATOM

1. Go to the naas server.log or the task log.
2. Look for the pattern “best match platform”.

2016-Apr-29 18:47:44.852 [http-bio-443-exec-55] !*c85c1b95-ff54-498f-8f74-f13434487b6f*! DEBUG
DevicePlatformService.getBestDevPlatformForTarget(334) - bestDevPlatformToMatch for the target
/controller/devices/device/vlans/vlan for the matching platform ALL|DCS-2759|Arista Networks 7150|Arista
EOS|Arista Networks is ALL|ALL|ALL|Arista EOS|Arista Networks

2016-Apr-29 18:47:44.857 [http-bio-443-exec-55] !*c85c1b95-ff54-498f-8f74-f13434487b6f*! INFO
RestStyleYangServiceImpl.processDeviceOperations(1252) - best matching platform ALL|ALL|ALL|Arista EOS|Arista
Networks

3. For operation best match platform found and respective command conditions are
validated and $ variables are replaced by values provided by the end user.

4. The detailed highlights are marked in red as shown below:
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5. If the best match platform is null, check if the device operations are defined in the
vendor-data.

6. In the ATOM UI, navigate to Administration >Plugins & Extensions > Device Support >
Operations

7. If the Operations are defined in the Device support and the commands are not being
generated still, check with Anuta Networks

8. However, if the operations have not been defined, create an operation in the UI.
 Solution

If device operation is not defined for the platform, define it by adding the Create, Update, and
Delete operations for that platform as illustrated below:

Attribute Error
 Error:
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 When the leaf is defined in yang and at the time of service creation the user gives an
empty value to that leaf, below error will be seen.

 
 Base-Object has no Attribute/object

 Solution
 To overcome the above exception, make sure that the user should add the

get_field_value like shown in below snippet to fetch the value from service yang and
assign it to create call.
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Sorting of Create/Delete commands:
After service instantiated sometimes commands will be generated in the wrong order in task
details, due to this operations can fail to execute on device. To overcome the failure follow
below procedure.

Example code :

Suppose devices will accept 'CreateQPolicyMap' command operations first and after that
'CreateInterface', 'UpdateInterface' command operations but commands generated in reverse
order in service task details, we need to write sorting for the Create/Delete commands like
below.

This class is already present in respective service_customization files. User needs to add the
move or delete operation like shown below.

class CreatePreProcessor(yang.SessionPreProcessor):

def processBeforeReserve(self, session):

operations = session.getOperations()

"""Add any move operations for creation"""

log('operations: %s' % (operations))

yang.moveOperations(operations, ['CreateInterface', 'UpdateInterface'], ['CreateQPolicyMap'], True)

Explanation for example code:

In above code CreateQPolicyMap command  will come before CreateInterface or
UpdateInterface command.

For deletion commands also same procedure.
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IPAM Pools integration with services:
To integrate the IP address pools with services, make sure that user can add code like below in
services.yang

After adding the leaf in yang, user will generate the code by using SDK, but in codegen bindings
of IPAM related methods will not be generated automatically if extensions are not used
properly. Users can add below code in some lib.py file and import those definitions wherever
needed.
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● Below method is used to get the used ips from ipaddresspool.

def get_used_ip_list_from_ippool(ipaddress_pool_name, sdata):

print "inside get_used_ip_list_from_ippool"

ipaddress_pool_name = util.make_interfacename(ipaddress_pool_name)

ipaddress_pool_name = ipaddress_pool_name.replace(' ', '%20')

ip_used_list = []

get_ipaddress_pool_url = "/app/restconf/data/ipam:ipaddress-pools/ipaddress-pool=%s"
%(ipaddress_pool_name)

pool = yang.Sdk.getData(get_ipaddress_pool_url, '', sdata.getTaskId())

pool = util.parseXmlString(pool)

if hasattr(pool.ipaddress_pool, 'ipaddress_entries'):

get_ipaddress_pool_entries_url =
"/app/restconf/data/ipam:ipaddress-pools/ipaddress-pool=%s/ipaddress-entries" %(ipaddress_pool_name)

entries = yang.Sdk.getData(get_ipaddress_pool_entries_url, '', sdata.getTaskId())

entries = util.parseXmlString(entries)

#print "list of ip_address_pool_entries is:", entries

if hasattr(entries.ipaddress_entries, 'ipaddress_entry'):

for entry in util.convert_to_list(entries.ipaddress_entries.ipaddress_entry):

ip_used_list.append(entry.ipaddress)

return ip_used_list

● Below method is used to add the ipaddress entries under ipaddress pools.

def add_ipaddress_entries(ipaddress_pool_name, ip_address,sdata):

payload = '<ipaddress-entries/>'

ipaddress_pool_name = util.make_interfacename(ipaddress_pool_name)

ipaddress_pool_name = ipaddress_pool_name.replace(' ', '%20')

url = '/app/restconf/data/ipam:ipaddress-pools/ipaddress-pool=%s'%(ipaddress_pool_name)

yang.Sdk.createData(url, payload, sdata.getSession(), False)

## Update used count

payload_ippool = '''<ipaddress-entry>

<ipaddress>'''+ip_address+'''</ipaddress>

<name>'''+ipaddress_pool_name+'_'+ip_address+'''</name>

</ipaddress-entry>'''
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yang.Sdk.createData("/app/restconf/data/ipam:ipaddress-pools/ipaddress-pool=%s/ipaddress-entries"
%(ipaddress_pool_name), payload_ippool, sdata.getSession())

● Below method is used to get the free ips from cidr.

def get_freeip_from_cidr(cidr, used_list):

print "inside get_freeip_from_cidr"

cidr_obj = util.IPPrefix(cidr)

gateway_ip = cidr_obj.gateway_ip()

#used_list.sort()

#ip_address = used_list[0]

#last_ip_address = used_list[used_list.__len__()-1]

network_given = IPNetwork(cidr)

(addrStr, cidrStr) = cidr.split('/')

addr = addrStr.split('.')

cidr = int(cidrStr)

mask = [0, 0, 0, 0]

for i in range(cidr):

mask[i/8] = mask[i/8] + (1 << (7 - i % 8))

net = []

for i in range(4):

net.append(int(addr[i]) & mask[i])

network = ".".join(map(str, net))

ip_address = network

print "gateway_ip for /32 cidr", gateway_ip

print "cidr_obj.masklen is", cidr_obj.masklen

if str(cidr_obj.masklen) == str(32):

return gateway_ip

else:

gateway_ip = util.next_ip_address(ip_address)

print "gateway_ip is:", gateway_ip

while (True):

if gateway_ip not in used_list:

break

else:

gateway_ip = util.next_ip_address(gateway_ip)

print "final gateway_ip is :", gateway_ip

104



ip = IPAddress(gateway_ip)

if not network_given.Contains(ip):

raise Exception('Invalid IP address for this cidr')

return gateway_ip

VLAN Pools integration with services:
To integrate the VLAN pools with services, make sure that user should add code like below in
services.yang

After adding the leaf in yang, user will generate the code by using SDK, but in codegen bindings
of VLAN pools related methods may not be generated automatically based on the extension
used. Users can add below code in some lib.py file and call those definitions when needed.

Below method is used to allocate the VLANs in a VLAN pool.

def allocate_vlan(dev, obj, sdata, pool, group, count=1):

print "poolname %s groupname %s"%(pool, group)

if util.isNotEmpty(count):

if util.isEmpty(pool):

raise Exception('Vlan pool cannot be empty')

allocated_list = []

for i in range(0,int(count)):

if i == 0:
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addr = vlanpool.allocate_vlan(group, pool)

else:

addr = vlanpool.allocate_vlan(group, pool, addr+1)

allocated_list.append(addr)

vlans_object = devices.device.vlans.vlans()

vlans_vlan_object = vlans_object.vlan.add(id=addr)

vlans_object_payload = vlans_object.getxml(filter=True)

log('vlans_object_payload: %s' % (vlans_object_payload))

return allocated_list

106


